
shree.p
Typewritten text
Mendeley Manual



 

Mendeley Manual for librarians 

2 

 

Table of Contents 

Using this manual ................................................................................................................. 4 

Overview ................................................................................................................................. 5 

Our commitment to responsible sharing .................................................................................... 5 

Accounts ................................................................................................................................ 6 

Creating an account ....................................................................................................................... 6 

Account limits ................................................................................................................................. 6 

Using Mendeley’s Reference Management Features ....................................................... 7 

Mendeley applications ................................................................................................................... 7 

Mendeley Desktop .......................................................................................................................... 8 

Overview ....................................................................................................................................... 8 

Layout ............................................................................................................................................ 8 

Adding references ......................................................................................................................... 9 

Storage .......................................................................................................................................... 9 

The Mendeley Web Catalog ....................................................................................................... 10 

Importing references ................................................................................................................... 11 

Importing references from online catalogs ................................................................................. 11 

Syncing........................................................................................................................................ 12 

Organizing references................................................................................................................. 12 

Search ......................................................................................................................................... 13 

The PDF Reader ......................................................................................................................... 14 

Collaboration ............................................................................................................................... 16 

Using the Citation Plugin ............................................................................................................ 17 

Discovery..................................................................................................................................... 20 

Mendeley mobile apps ................................................................................................................. 20 

Overview ..................................................................................................................................... 21 

iPhone & iPad ............................................................................................................................. 21 

Android ........................................................................................................................................ 21 

Mendeley Web ............................................................................................................................... 22 

Overview ..................................................................................................................................... 22 

Web Library ................................................................................................................................. 22 

Groups in Mendeley Web ........................................................................................................... 26 

The Web Catalog ........................................................................................................................ 29 

Mendeley Web Importer ............................................................................................................. 30 

Using Mendeley’s social features ..................................................................................... 31 

Mendeley profiles ......................................................................................................................... 31 

Completing your profile ............................................................................................................... 32 

Changing account settings ......................................................................................................... 33 

Connecting with other researchers ............................................................................................ 34 

Finding other Mendeley Users .................................................................................................... 34 

Following ..................................................................................................................................... 34 

Messages .................................................................................................................................... 34 



 

Mendeley Manual for librarians 

3 

Mendeley Suggest ........................................................................................................................ 35 

Mendeley Stats ............................................................................................................................. 35 

Claiming a Scopus Author Profile ............................................................................................... 36 

Using Stats .................................................................................................................................. 36 

Reporting problems with Stats .................................................................................................... 37 

Mendeley Data .............................................................................................................................. 37 

Mendeley Careers ......................................................................................................................... 39 

Mendeley Institutional Edition (MIE) ................................................................................. 40 

Benefits of MIE .............................................................................................................................. 40 

Institution-wide access to premium features .............................................................................. 40 

Institutional Page with Insights for librarians .............................................................................. 41 

Alumni Policy ............................................................................................................................... 44 

Support promoting Mendeley and training users at your Institution .......................................... 44 

24/5 priority global customer support ......................................................................................... 44 

MIE and Librarian Certification.......................................................................................... 44 

 

 

  



 

Mendeley Manual for librarians 

5 

Overview 
Mendeley is a free* reference manager and academic social network. It helps researchers to organize 

their materials, to collaborate with others online, to discover the latest research in their field and find 

career opportunities.  

Mendeley has over 6.5 million users worldwide. Although its user interface is currently only available in 

English, its intuitive layout and usability make it popular with researchers everywhere. 

Mendeley provides an online account (see Accounts) that allows a user to build a personal library of 

references. References can be added to this library by using papers in PDF format, by importing from 

online catalogs or by manually adding the details of a reference. Users can also easily migrate their 

references to Mendeley from other reference managers. 

By adding references to a library, users are able to keep track of their materials, to organize them as 

they see fit and read & annotate PDF documents. The Mendeley Citation Plugin then allows users to 

insert citations using references in their library, setting them out according to specific style rules 

(choosing from over 7,000 available citation styles). Once a manuscript has been completed, the 

Citation Plugin will also generate a full bibliography at the click of a button. 

Libraries are stored in the cloud, meaning they are accessible from any location with an Internet 

connection. Users can download the Mendeley Desktop application (available for Windows, OSX and 

Linux), the mobile applications (iOS and Android) or access a web-based view of their library from any 

browser. 

In addition to reference management, Mendeley provides features to allow researchers to collaborate 

together. By creating and joining groups, users can share resources and ideas with one another 

directly. Mendeley’s other social features allow users to create a personal profile, connect with other 

researchers and to discover important new work in their field as well as understand the impact of 

publications.  

Mendeley is owned by Elsevier, but is committed to offering a publisher-neutral service. Papers from 

any journal or publication can be used with Mendeley, and Mendeley also supports importing and 

exporting library content from a number of widely used formats. Users of other Elsevier products – such 

as Science Direct and Scopus – will benefit from certain integrations and enhancements. 

Our commitment to responsible sharing 
Mendeley expands the range of services available to researchers for academic collaboration and 

publication sharing. Our joint key principle is that sharing should be done in ways that are responsible, 

sustainable and don’t undermine the ability of publishers to deliver the high-quality research articles that 

scholars wish to share in the first place. Mendeley: 

• Promote responsible sharing. 

• Endorse and adhere to the industry’s ‘Voluntary Principles for Article Sharing on Scholarly 
Collaboration Networks’†. 

• Actively monitor copyright infringement. 

• Work closely with other publishers and research information providers to ensure that we are 
compliant at all policy levels. 

• Provide researchers and libraries with clear guidance on posting and copyright policies.  

                                                 
* Mendeley offers a ‘freemium’ model. Accounts are free to create and use, but certain limits apply to the amount of storage these 
accounts have available, as well as the ability to create private groups. See below for more details.  
† For further details please visit http://mnd.ly/29xHAkx 

http://www.elsevier.com/
http://www.sciencedirect.com/
http://www.scopus.com/
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Accounts 

Creating an account 
Creating a Mendeley account is very straightforward and only takes a few seconds.  

Visit www.mendeley.com and follow the ‘Create a free account’ link to be taken to the registration tool. 

You just need to provide a few basic details about yourself, including an email address. Although any 

email address will work, it’s best to use an institutional email address (i.e. one provided by your school 

or university) as this helps Mendeley to verify your association with the institution. Researchers who 

register with their institutional email address will also automatically benefit from certain benefits if the 

institution purchases or has already purchased a Mendeley Institutional Edition (MIE) subscription. 

Once you’ve created a Mendeley account, you’ll be prompted to verify your email address. It’s 

important to complete this step in order to allow you to recover your account in the event that you forget 

your password. 

If your email address has already been used to create an account for another Elsevier product (such as 

Science Direct or Scopus) you will be prompted to log into this account. Using the same account across 

Elsevier products provides an enhanced experience. 

Account limits 
A free Mendeley account allows users to the vast majority of Mendeley’s features, although there are 

some limitations in place. A free account receives: 

• 2GB personal cloud storage 

• The ability to create 5 restricted group (private/invite-only) of up to 25 members 

• 100MB team cloud storage 

Mendeley offers the ability to purchase upgrades to these restrictions by purchasing a Personal Storage 

Plan. These ‘premium packages’ are usually purchased by independent research teams or companies. 

An institution with a Mendeley Institutional Edition subscription (see below) receives premium account 

upgrades for all its users (authorized using institutional email addresses). As part of the Mendeley 

Librarian Certification Program’s Level 3 reward, certified librarians are given 500 premium account 

upgrades‡ to distribute amongst users at their institution. These premium accounts will last 12 months 

and benefit from the following allowances: 

 Librarian Certification Program Mendeley Institutional Edition 

Seats 500 Unlimited 

Personal storage 5GB 5GB 

Shared storage 20GB 20GB 

# Private groups Unlimited Unlimited 

# Collaborators per group Up to 50 Up to 100 

 

  

                                                 
‡ Limited to 1 librarian per institution, although multiple librarians can contribute to the level 3 assessment.  

http://www.mendeley.com/
http://www.sciencedirect.com/
http://www.scopus.com/
https://www.mendeley.com/upgrade/storage/
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Using Mendeley’s Reference Management Features  
Once a Mendeley account has been created, you’re ready to start using Mendeley’s applications to 

build a personal reference library. 

Your Mendeley library is stored in the cloud, meaning it can be accessed from different applications, 

running on different devices, in different locations. Changes made during different sessions need to 

be ‘synced’ across devices to ensure that the most current version is available on each. 

Mendeley applications 
These applications are designed for use in different circumstances, and you should familiarize 

yourself with the strengths of each: 

• Mendeley Desktop – This is Mendeley is its original and most commonly used form. The vast 
majority of Mendeley users use the Desktop version on a regular basis. This is a desktop 
application, which needs to be downloaded and installed. Mendeley Desktop is compatible with 
Windows, OSX and Linux. 

o Advantages: 
▪ Allows all Mendeley features, including importing, reading, annotation, 

organization, searching, collaboration via groups and discovery. 
▪ Compatible with Mendeley Citation Plugin – to use Mendeley’s write & cite 

functionality Mendeley Desktop must be installed. 
▪ Provides access to different citation styles – including the ability to install new 

styles from a repository of over 7,000 options. 
o Restrictions: 

▪ Must be installed on computer, and best used on a personal laptop or desktop. 
Library computers may sometimes prevent installation of software. 

• Mendeley Mobile – Dedicated apps are available for iPhone, iPad and Android. These apps 
can be installed on phones and other devices (such as tablets). The Mobile applications are 
designed to be more useful for reading and annotation on the go or in situations where portable 
devices are preferred (such as in a laboratory). 

o Advantages: 
▪ Allows importing, reading, annotation, organization, searching, collaboration via 

groups, discover via Mendeley Suggest and provides basic article’s readership 
metrics. 

▪ Improved reading and annotation experience on smaller devices. 
▪ Allows user to control which files are downloaded, preventing excessive data 

consumption on non-wifi connections. 
o Restrictions: 

▪ Does not allow writing and citing. 

• Mendeley Web Library – The Web Library allows you to access your Mendeley library from 
any modern web browser. It provides a similar user interface to Mendeley Desktop. 

o Advantages: 
▪ Allows importing, reading, annotation, organization, searching and (limited) 

collaboration via groups. 
▪ Designed for quick access reading and annotation. 
▪ Can be used on any computer with an Internet connection – removing the need 

to install software. 
o Restrictions: 

▪ Citing while writing although possible is not as straightforward as it is on 
Mendeley Desktop. 

• Social Features – Mendeley’s social features allow users to build an online profile to promote 
themselves and their work, as well as connecting with other users. A number of new features 
have been recently released to improve this experience. 

o Profiles – A basic Mendeley profile is generated at the time of account creation, but 
extra information can be added to reflect career activity and interests. An active 
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Mendeley account also makes it easy for other users to connect with you and reach out 
via private message, or via discussion in Mendeley groups. Mendeley integrates with 
ORCID, the Open Research Contribution ID non-profit, to bring unique research 
identification to Mendeley Profiles.  

o Groups – Groups are Mendeley’s main collaborative feature. A user is able to create 
and join teams of people in order to share references and other resources. Groups are 
usually dedicated to a specific objective or may also be subject-specific. 

o Suggest – Available at www.mendeley.com/suggest/. Previously a premium-only 
feature, Suggest was made available to all Mendeley users at the start of 2016. It uses 
information about your profile, library and reading habits to generate bespoke 
recommendations. 

o Stats – Available at www.mendeley.com/stats/. Allows published authors to connect 
their Scopus Author Profile to their Mendeley profile, revealing usage statistics about 
papers. 

See the section below on using Mendeley’s social features for more details. 

Mendeley Desktop 
Overview 
Mendeley Desktop is still the ‘core’ Mendeley experience, and is the most commonly used Mendeley 

application. Because it is required to use the writing and citing features provided by the Citation Plugin, 

it tends to be very popular with those users who are doing a lot of paper writing. 

 

Layout 
Broadly speaking, Mendeley Desktop offers a three-column view. The left-most column allows ‘high 

level’ navigation, with a number of different view filters available from the time of installation. Users can 

also create custom filters for their documents – ‘folders’ – which will also be listed in this column. 

The main column provides a list of references, along with details of each entry. These details – such as 

a paper’s title, author and year of publication - are displayed in columns within the main panel. When 

using a view filter- selected in the left-hand column (e.g. Recently Added) - only the relevant documents 

http://www.mendeley.com/suggest/
http://www.mendeley.com/stats/
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will be displayed in the main panel. Selecting ‘All Documents’ will always display the entire contents of a 

library. 

The right-hand column displays all the details of the currently selected reference. This column should 

be used to ensure that a reference’s details have been entered correctly. Clicking on a field allows 

existing details to be modified or missing details to be added. 

Adding references 
Building a Mendeley library requires adding references. There are several ways to get references into 

your library using Mendeley Desktop (detailed in this section), but it’s also recommended that users 

install the Mendeley Web Importer, which is covered below. 

• The simplest way to add a file (such as a PDF of a paper) to Mendeley is to drag and drop it into 
the main window. This will cause Mendeley to automatically create a new entry for the paper. 

[TIP - METADATA EXTRACTION: When adding a PDF paper to Mendeley, Mendeley will attempt to 

extract the metadata (such as Author, Title etc.) from the paper to use for the document details. 

Although this is undertaken using sophisticated algorithms, the sheer variety of formatting options for 

papers means that this can never be 100% accurate. Always check the details of a newly added 

paper to verify the details Mendeley finds.] 

• Single files can also be added using the ‘Add Files’ command, found under the File menu. This 
will allow you to browse your computer for a specific file and add it to your library. 

• The entire contents of a folder (e.g. multiple PDFs stored in the same location) can be added 
using the ‘Add Folder’ found under the File menu. 

• You can opt to ‘Watch’ a folder using the ‘Watch Folder’ command found under the File menu. 
This allows you to specify a folder on your computer for Mendeley to monitor. Whenever a new 
file is added to this folder, it will be automatically imported into Mendeley. 

• For references, other than PDF papers, it’s possible to create a ‘metadata only’ entry in your 
library. This can be useful for books and other non-digital (or non-text) media. To create a 
manual entry, select the ‘Add Entry Manually’ command, found under the File menu. This opens 
a tool that allows you to specify the reference type, and to input the document details yourself. 

Storage 
Reference and PDF papers added to your personal library are stored in the cloud, which allows them to 

be retrieved whenever and wherever you need them. Files stored in your library count towards a 

storage limit which is applied your account. The amount of storage depends on your account type. You 

can check your storage usage at any time via the ‘General’ tab of the Preferences menu.  
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The Mendeley Web Catalog 
Mendeley takes all references added by users and adds them to the Mendeley Web Catalog. 

Sophisticated algorithms analyze each entry, allowing the system to identify where multiple users have 

added the same paper and to identify the correct details for that document. 

For example, if three users all add the same paper with identical document details, the Catalog will be 

fairly confident that those details reflect the correct details of the paper. 

If three users add the same paper, but one user includes a typo in the title of the paper, the correct title 

is more likely to be taken due to the weight of numbers. Papers imported from a respected source – 

such as Science Direct – are also regarded as more trustworthy. 

Opting out of the Web Catalog 

The Web Catalog is used to identify patterns in research and to power recommendations. No user data 

is shared with the Catalog, so it’s not possible to see the contents of an individual library. However, it is 

possible to opt out individual references that may be particularly sensitive. 

This can be done by checking the ‘Unpublished work – exclude from Mendeley Web Catalog’ setting 

which appears at the bottom of the document details column. 
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Importing references 
Mendeley Desktop can also import existing references from other reference managers. Currently this 

includes the following: 

• Endnote 

• Zotero 

• Refworks 

• Any other reference manager that can export to .ris or BibTeX formats 

To import an output file from another reference manager, open the File menu of Mendeley Desktop and 

open the ‘Import’ menu. Select the appropriate file type from the list, locate the file on your computer 

and press ‘Ok’ to start the import process.  

Importing references from online catalogs 
Many online catalogs offer the ability to export a reference or multiple references to a Mendeley library. 

Several, such as Science Direct and Scopus, offer direct integration. With a reference selected, open 

the ‘Export’ menu and use the ‘Save to Mendeley’ option. If you aren’t already logged into your 

Mendeley account, you’ll be prompted to do so. Once the export is completed the various references 

will be available in your Mendeley library after the next sync. 

Other catalogs that allow exporting references to the .ris format will also work with Mendeley. Save the 

.ris file to your computer and then add it to Mendeley using ‘File’ > ‘Add File’. Mendeley will create 

entries for all references included in the export file. 

http://www.sciencedirect.com/
http://www.scopus.com/
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Mendeley can also import BibTeX and Endnote-compatible xml. 

Syncing 
After making any changes to your library it’s very important to ‘sync’ Mendeley. This ensures that the 

changes you have made are pushed up to the cloud for storage. By saving your changes in the cloud, 

these amendments will be available when you next access your library, whether it’s from the same 

computer or from a totally different device.  

 

Mendeley will automatically sync each time it’s opened (in order to check for changes made 

elsewhere), but you can initiate a sync at any time by using the button on the main toolbar. 

Always remember to sync frequently when making changes to your library. 

Organizing references 
Mendeley offers a number of different options to help organize a personal library: 

• Ordering – At any time you can reorder the list of references in the central column by clicking 
the various column headings. This can be useful when you need to order by Author, Title or 
Year, for example. 

• Folders – Folders allow a user to filter their view. They are created using the ‘Create Folder’ 
option that appears in the left-hand column – or by using the button on the toolbar. Subfolders 
can be created within a parent folder, to allow greater precision when filing. 
References are added to a folder by dragging and dropping them into the appropriate entry in 
the left-hand column.  When a folder is selected, the main panel of Mendeley Desktop will only 
display references that have been added to the selected folder. References can be added to 
multiple folders. Rather than thinking of them as a way to store your references, it’s better to 
regard folders as a way of quickly filtering your library view. 

• Tags – Tags allow a user to very quickly label a specific reference with a keyword for easy 
retrieval.  
Tags are added to a reference using the document details panel, with multiple tags being 
separated by semicolons (‘;’). Once added, they will appear in the Filter tool, which appears in 
the bottom left panel of Mendeley Desktop.  
Clicking on a tag that appears in the ‘Filter by tag’ list will only display references with that 
specific tag. 

[TIP - CONTEXT SPECIFIC FILTERING: When using tags – and also search – Mendeley will filter 

the view on top of any current filtering. If you’re viewing a particular folder (i.e. a filtered view), 

selecting a tag from the Filter tool will apply the new filter on top. You will also only be able to select 

from tags that are used on references within that folder. 

For example: You’re looking for a particular paper, which you know applies to the treatment of lung 

cancer. You have a folder, which contains all papers relating to lung cancer, so you select that in the 

left-hand menu. The list of available tags in the Filter tool is now substantially reduced, since you’re 

no longer viewing All Documents. You then select the ‘Treatment’ tag within the Filter tool. This 

returns only items that are in the lung cancer folder and also have the ‘Treatment’ tag, allowing you 

to rapidly cut down the number of items you need to check through.] 
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• Recently Added – This left-hand column option will display the references that you’ve most 
recently added to your library. 

• Recently Read – This left-hand column option only applies to PDF files added to your library. It 
will display a list of the PDF files you’ve recently opened for reading on any Mendeley 
application – and will also take you back to wherever you had reached in the paper when you 
reopen the file. 

• Favorites – At any time you are able to ‘star’ a reference by clicking on the star that appears 
next to its entry in your Mendeley library. This will mark the item as a ‘Favorite’ and add it to the 
Favorites option in the left-hand column. 

• Needs Review – This left-hand column option will list any items which Mendeley has imported, 
but has reason to suggest that the document details need review. This may be because the 
metadata extraction process has struggled with some elements. Once a reference has been 
marked as having been reviewed by the user, it will be removed from this list. 

• My Publications – This folder is used for adding your own personally authored publications to 
Mendeley. By adding a paper using this tool, you are asserting that you are one of the listed 
authors. The paper will be added to your Mendeley profile, allowing others to see your 
authorship. 

• Unsorted – This folder is used to store documents which have not been added to any 
collections in your library.  

Search 
Mendeley Desktop includes a powerful search function, which allows you to quickly find items in your 

library. 

To begin a search, just enter a keyword in the box that appears in the top right corner of the Mendeley 

Desktop Interface. Matching results will be returned in the central panel. 

Mendeley will not only match items which contain the keyword in their document details, but will also 

return PDF files that contain the keyword within them. 

[TIP - CONTEXT SPECIFIC SEARCH: Note that like the filtering options discussed above, Mendeley’s 

search tool is content-specific. If you’re viewing a particular folder and initiate a search, Mendeley will 

initially only search within the selected folder. 

This can allow you to rapidly narrow the number of items being searched, but if you want to search your 

entire library, make sure ‘All Documents’ is selected in the left-hand column.] 

In addition to a quick search, you can also opt to search particular elements of the document details by 

clicking the dropdown arrow that appears next to the magnifying glass when the search field is active. 

This provides you with the following search options (which can also be entered manually): 

• Authors: 

• Titles: 

• Publication Names: 

• Year: 

• Notes: 

To clear a search and return to the full view, click the ‘Clear’ button, which appears on the yellow 

notification bar that displays after a search is made. Alternatively, deleting the contents of the search 

field will also cancel a search. 
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The PDF Reader 
 

 

PDF papers that have been added to Mendeley (indicated by a small PDF icon appearing next to the 

author name) can be opened for reading using the Mendeley PDF Reader. The PDF Reader provides 

many similar features to other PDF software, but with several extra features that enhance the reading 

and note taking experience. 

To open a PDF for reading, double click on an entry that includes a PDF icon. Open papers will each 

appear as a tab below the main toolbar, allowing you to switch between multiple papers. ‘My Library’ 

will also appear as a separate tab, allowing you to switch back to the library view at any time.  

When you close a paper, Mendeley will remember your position within the document and take you back 

to the same location when you next open the paper. 

In addition to the main reading panel, you will also see the document details panel displayed. This 

allows you to verify the details of the document you’re reading, and to make amendments as 

necessary. The additional tabs allow you to access your notes (covered in more detail below), and the 

document contents for quick navigation. Note that the contents tab is only available in papers that have 

had this information included by the publisher. 

The PDF toolbar allows you to change the page view as you see fit, by using the rotate, zoom and full-

screen commands. 

Annotation 

In addition to reading the paper, Mendeley also allows you to collect your thoughts in the form of 

annotations. These can be added in several ways: 
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• Highlighting – Select the highlight tool from the toolbar to allow you to highlight relevant 
passages. You can switch between cursor highlighting, and dragging a rectangle to apply 
highlighting to the selected area. 
Clicking on a highlighted passage will focus the reader on that section, making the highlighted 
passage easier to read. To exit this mode, click outside the highlighted area. 
To delete highlighting, right click it and select ‘Remove Highlight’. Note that this is not available 
when the reader is focused on a highlighted passage. 
 

 
 

• Sticky Notes – Select this tool and click a location to apply a Sticky Note to the text. 
Alternatively, you can right click in the appropriate position and select ‘Add Note’. Sticky Notes 
allow you to add a comment or in a specific location within the text. The note will be time-
stamped to help you keep track of your thoughts. 
Sticky notes will also be added to the Notes tab of the document details panel. These entries 
are also linked to the relevant Sticky Note - clicking them will take you to the position of that 
note within the text. 
These notes cannot be searched using the search tool. 
 

 
 

• Document-wide notes – Found in the Notes tab of the document details panel, this field allows 
you to make general notes about a paper.  
These notes can also be accessed from the main library view, which allows them to be applied 
to both PDF papers and metadata only references. 
These notes can be searched using the search tool. 

Exporting annotations 

Highlighting and annotation applied to a PDF document are not added to the original PDF you may 

have used when importing the reference. 

You can export a copy of the PDF with your annotations included by opening the ‘File’ menu and 

selecting the ‘Export PDF with Annotations…’ option. 

This will allow you to save a separate copy of the PDF, complete with highlights you’ve added. The 

locations of sticky notes will be indicated by icons, with the contents of the notes listed on an appended 

page. 
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Collaboration 
Mendeley’s main collaborative feature is groups. Groups are user-created collections of resources that 

are made available to other Mendeley users. For more advanced group functionalities check Groups in 

Mendeley Web 

There are three different types of Mendeley groups: 

• Open – This type of Group is totally public and can be joined by anyone. It will appear in the list 
of groups available on Mendeley.com. Public groups allow discussion and the sharing of 
references, but only the reference metadata can be shared. 
Any group member can add, modify and delete references shared with the group. Others can 
‘follow’ the group to see the references added to it. 
Open groups are a good way to share large numbers of references with others, as well as 
inviting others to share references in return. 
 

• Invite-only – This type of Group is also publicly visible and can be found using the group 
search tool. However, it limits the membership to those invited to join by the group owner (or by 
an appointed administrator). Others can ‘follow’ the group to see the references added to it, but 
only full members can add, modify or remove references. As it is a public group, only reference 
metadata can be shared. 
Invite-only groups are ‘restricted’ groups and the size of their membership is limited when 
created by free accounts. 
Invite-only groups are a good way to share fixed lists of references with a wide group. They are 
often used for reading lists. 
 

• Private – Private groups are totally private. They cannot be found using the group search tool – 
members need to be invited to join. 
Private groups are the only group type which allow the sharing of full-text papers. In addition, 
notes and annotations added by group members are also visible to other members, allowing 
specific passages to be pointed out, and suggestions to be made. Each contributor receives 
their own unique color to identify their input. 
Private groups are intended for research teams or project groups to collaborate on texts, shared 
on a fair-use basis. As such, membership of private groups is strictly limited – they are also 
treated as ‘restricted’. 

Any Mendeley user can create groups – although some restrictions do apply. Groups are used to share 

references, notes and to host discussion.  

Creating a group 

Creating a group in Mendeley Desktop can be easily done in just a few steps: 

1. Under the ‘Groups’ heading in the left-hand column, click the ‘Create Group’ command. 
2. When the tool opens, you’ll be asked to provide some basic details about your group, including 

its name and a description. 
3. You’ll also need to select a Group Type. See above for details of each type. 
4. Once you’ve provided the details of your group, it will be created immediately. You can begin 

inviting people to join it using their email addresses, or – if you already follow them on Mendeley 
– they will be suggested when you start typing their name. 

You can find a more detailed guide to Groups in the Mendeley Resource Center. 

You can also find a dedicated guide to Private Groups in the Mendeley Resource Center. 

Once a Group has been created, it will appear under the Groups heading in the left-hand column of 

Mendeley Desktop. Any other groups you create or join will also appear here. 

https://www.mendeley.com/guides
https://community.mendeley.com/guides/private-groups
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A safe icon indicates that the group is private, while a folder icon indicates a public group. A folder with 

a small head and shoulders icon indicates a group of which you are a full member. A folder with a blue 

arrow indicates that you are following that group and are not a member. 

Inviting members to a group 

Public groups (Open and Invite-Only) can be found and joined by users using the group search tool on 

Mendeley.com. You can also invite people to join a public group if you think they should become 

members. Private groups can only be joined by invitation. 

To invite others to a group in Mendeley Desktop, click on the ‘Members’ tab. You’ll find an invite tool in 

the top-left of the central panel. You can either enter an email address, or start typing the name of 

someone you follow on Mendeley in order to be prompted to select them as an invitee. 

Click the ‘Send’ button to complete the process. If sending an invite by email to someone without a 

Mendeley account, they’ll be prompted to sign up before they can join the group. 

Adding references to a group 

In order to share references with other group members, you need to drag and drop them onto the 

appropriate entry in the left-hand column of Mendeley Desktop, just as you would with folders.  

[TIP – Personal Annotations: Note that, in the case of PDF papers, any annotations or notes that you 

may have added to the reference in your personal library will not be carried across. Adding the paper to 

a group effectively creates a fresh copy of the paper.] 

Accessing groups 

When clicking on a group’s name, you’ll initially be taken to the discussion page. This keeps track of 

who has added references to a group, with notifications appearing in a newsfeed format. Discussion 

threads can also be created. You can ‘Like’ individual posts and also add comments. 

Switch to the ‘Documents’ tab of the group to see all of the references that have been shared with that 

group. If you are a full member, you can modify the document details of each reference. If viewing a 

private group, full-text documents will display a download icon next to their entry. Click this to retrieve 

the group copy of the PDF. 

You can opt to download all PDFs associated with a group of which you are a member via the ‘Edit 

Settings’ button. 

Storage 

In addition to the personal storage limit discussed above, a separate storage limit applies to references 

shared with private groups. PDFs added to a group count towards the storage limit, which is tied to the 

account of the group owner. 

Free accounts have 100MB of group storage. Premium accounts – such as those distributed by 

certified librarians – have 20GB. 

All groups owned by an account contribute to that account’s group storage limit. 

Using the Citation Plugin 
One of Mendeley’s most popular features is its ability to manage the insertion of citations into a 

manuscript, and to also generate a full bibliography automatically. The citations present in a document 

can also be instantly restyled for compatibility with different citation requirements. 
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These features powered by the Citation Plugin – a tool that is added to your word processor to create a 

direct link to Mendeley. 

The Citation Plugin currently supports Microsoft Word (on Windows and Mac) and the free alternative 

Libre Office (on Windows, Mac and Linux).  

You must have Mendeley Desktop installed in order to use the Citation Plugin. 

Installing the Citation Plugin 

The Citation Plugin is installed via the ‘Tools’ menu in Mendeley Desktop.  

The options available to you will depend on which word processor(s) you have installed on your 

computer.  

Choose the appropriate option to begin the installation process, and follow the instructions that appear. 

The process only takes a few moments to complete, and Mendeley will notify you that the installation 

has been successful. 

Using the Citation Plugin 

When you reopen the word processor, you should see the Mendeley toolbar. The exact location will 

depend on the software and operating system you’re using. 

• In Libre Office, the Mendeley toolbar will appear as a free-floating toolbar that can be resized 
and re-positioned according to your personal preference 

• In older versions of Microsoft Word, the Mendeley toolbar will appear in the ‘References’ tab of 
the Word Ribbon. The citation plugin supports versions of Microsoft Word from 2010 onwards.   

• In Microsoft Word 2016, the Mendeley toolbar appears under the ‘Add-Ins’ section. 

The toolbar is comprised of a number of buttons and menus (the specific order varies between word 

processors): 

• Insert Citation (or Insert/Edit Citation) – This button will begin the process of inserting a 
citation wherever the cursor is currently located. When clicked, it opens the Citation tool that 
allows you to search your Mendeley library for a specific reference. 
When the cursor is positioned within an existing Mendeley Citation, this button will allow you to 
edit that citation instead. 
The current Citation Style controls the format of the citation. See below for more details. 

• Undo Edit – Use this button to undo any changes made to Mendeley citations. 

• Merge Citations – With two adjacent citations block highlighted, pressing this button will 
combine them into a single, properly formatted citation. 

• Insert Bibliography – Creates a bibliography of all the Mendeley citations inserted into the 
current document. The bibliography will be inserted at the cursor’s current location. 
The current Citation Style controls the format of the bibliography. See below for more details. 

• Refresh – This will update all the Mendeley citations and bibliography to use the most current 
details for each reference. If you correct an Author Name in Mendeley Desktop, for example, 
you will need to press Refresh for that change to be updated in any citations added to the 
current document 
Note that inserting another citation, or bibliography, as well as updating the current Citation 
Style will also cause the document to refresh. 

[TIP – Mendeley Fields: The Mendeley Citation Plugin works by adding a piece of detailed 

code at the location you insert a citation. This is then ‘masked’ to display the relevant details in 

the appropriate style. This allows Mendeley to restyle the existing citations on the fly – but it also 

means that manual changes to an inserted Mendeley field will be reverted the next time the 

document refreshes. 
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If you need to make a correction to any of the reference’s details, make them in Mendeley 

Desktop. This change will then propagate to the document as of the next refresh. To add 

specific details to a particular reference (such as page number), you should instead ‘Edit’ the 

citation, as discussed above. 

Alternatively, you can wait until the document is completed, then ‘flatten’ it to remove the 

Mendeley Fields (see tip below). This will convert the citations to plain text, allowing you to 

make changes, but will prevent you from being able to restyle the citations, or automatically 

update the bibliography.] 

• Citation Styles – Use this dropdown menu to select the active Citation Style for your document. 
Mendeley will display a number of the most popular styles by default, but you can also use 
‘More Styles’ to be taken to the styles menu in Mendeley Desktop. This allows you to download 
additional citation styles from a repository of over 7,000 community-generated styles. 

• Export – This allows you to save a separate copy of your document. This can be used to carry 
across Mendeley citations into a format compatible with another word processor (e.g. from 
Microsoft Word to Libre Office, or vice versa). It can also be used to save a copy without 
Mendeley Fields. This process is sometimes known as ‘flattening’. 

[TIP – Flattening: Before finishing a document, you should remove the Mendeley fields by 

flattening the document (done via the Export menu on the Mendeley Citation Plugin toolbar). 

This will remove the code that powers the Mendeley Fields, converting the entire document to 

plain text.  

Once this has been done you will no longer be able to restyle your document, and the 

bibliography will no longer automatically update to include new references – so make sure you 

are totally happy with your references before undertaking this step.] 

Citation Style Language (CSL) 

Citation Style Language (CSL) is a type of code, used by Mendeley, to control the way in which 

citations and the bibliography are set out. 

Different publishers and journals require different information to be provided, and for the contents to be 

formatted in different ways. CSL allows Mendeley to apply different formatting rules to citations on the 

fly, so you can switch from using APA to IEEE with a single click. 

Mendeley comes with several population citation styles already installed, but you can also find and 

install new citation styles (choosing from repository of over 7,000 items). You can even customize a 

style, or create a new style from scratch, using Mendeley’s CSL Editor. 

Installing new styles 

In Mendeley Desktop, open the ‘View’ menu, and then open the ‘Citation Style’ submenu. This shows a 

list of installed, recently used styles. Click ‘More Styles’ to view a full list of all installed citation styles. 

Click on a style and press the ‘Use this style’ button to set it as active. 

Switch to the ‘Get More Styles’ tab to search for a new style. Enter a keyword associated with the style 

you want in order to view a list of possible results. 

Once you’ve found the appropriate style, click it and then click the ‘Install’ button in order to download 

the style. This style will now be available for you to use. 

Previewing a style 

To preview how the active style will look when used, open the ‘View’ menu and choose ‘Library as 

Citations’. This will display entries in your library as if they were citations. 
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Use ‘View’ > ‘Library as Table’ to return to the default view. 

Localizing your citations 

When citations are generated, certain elements (such as ‘et al’) are automatically included. Many 

languages do not use these terms, so it is possible to localize them to use alternatives. 

Open the Citation Styles menu using ‘View’ > ‘Citation Styles’ > ‘More Styles’ and make sure the 

‘Installed’ tab is active. At the bottom of the window is a dropdown menu labeled ‘Citation and 

Bibliography Language’. Choose the appropriate language from this list in order to use the localized 

terms in your manuscript. 

Modifying or creating a new style 

The Mendeley CSL Editor can be accessed via http://csl.mendeley.com/about/.  

For details of how to use the editor, see the dedicated guide in the Mendeley Resources Center. 

 

Discovery 
Mendeley Desktop also offers a number of ways to discover new relevant research. These can be used 

to retrieve the document details for a reference – to access the full-text of a new paper, you will need to 

visit the original publisher for details of how to gain access. 

• Mendeley Suggest – Previously only available to premium account holders, Mendeley Suggest 
was opened to all users at the start of 2016. Visit www.mendeley.com/suggest to get started. 
By looking at a number of factors – including your area of study, the contents of your library and 
your most recently added references – Mendeley Suggest will make personal recommendations 
for you. You can then add them to your library with just one click. Make sure to Sync Mendeley 
Desktop to pull down any new additions. 

• Related Papers – Right click on a single paper, or select several papers before right clicking, 
and choose ‘Related Papers’. This will consult Mendeley’s Web Catalog for papers commonly 
used in conjunction with your selected item(s). 

• Literature Search – Use this option, which appears in the top of the left-hand column, to search 
Mendeley’s Web Catalog for a keyword or phrase. Click to select a result, and then choose 
‘Save Reference’, which appears in the document details column. 
Note that as this is only searching the Mendeley Web Catalog, it will only look at papers that 
have been added by other Mendeley users. 

Mendeley mobile apps 
 

https://community.mendeley.com/guides/csl-editor
http://www.mendeley.com/suggest
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Overview 
Mendeley Desktop remains the most popular way to make use of Mendeley’s main features, but users 

increasingly need to access their reference materials from other types of devices (such as tablets or 

phones). Mendeley’s mobile applications were therefore developed in order to provide library access 

while on the go, or in the lab. 

The mobile applications are intended to act as ‘companions’ for wider Mendeley usage and are 

designed to focus on the reading and annotation of papers. It’s recommended that the apps are used in 

conjunction with Mendeley Desktop for the best experience. 

iPhone & iPad 
The Mendeley App is designed to work on iPhones and iPads alike. It can be downloaded from the 

Apple App Store. 

For a full guide to using the iOS application, see the dedicated guide in the Mendeley Resources 

Center. 

Android 
The Android application is designed to work with any device running the Android operating system – 

including phones and tablets. It can be downloaded from the Google Play Store. 

For a full guide to using the Android application, see the dedicated guide in the Mendeley Resources 

Center. 

 

  

https://community.mendeley.com/guides/ios
https://community.mendeley.com/guides/ios
https://community.mendeley.com/guides/android
https://community.mendeley.com/guides/android
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Mendeley Web 
 

 

Overview 
Mendeley Web has several objectives: 

• To allow users to access Mendeley functionality – such as their personal library – through a web 
browser, providing access whenever and wherever it may be required. 

• To allow users to easily grow their personal libraries by adding materials from online catalogs. 

• To provide a social space for users to connect with others, to build & grow their personal profile 
and to manage key career milestones. 

• To allow users to cite on Microsoft Word directly, without using Mendeley desktop 

• To search for career opportunities on Mendeley careers 

• To store and share datasets on Mendeley data 

To achieve these, Mendeley.com provides a number of services. Many of these serve one or more of 

these objectives. 

Web Library 
Accessible via www.mendeley.com/library, this allows a user to access a browser-based version of their 

personal library. It offers a similar interface to Mendeley Desktop, but has been optimized for web 

viewing. It was also designed to work well on tablets – meaning that it can be used as an alternative to 

the dedicated applications on devices running alternative operating systems. 

Layout 

The Web Library uses a three-column interface, following the same approach as Mendeley Desktop. 

http://www.mendeley.com/library
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The left-hand column allows for the filtering of the library view. In addition to Favorites and Recently 

Read – which work in the same way as in Mendeley Desktop – all of a user’s personal folders will also 

be displayed by default. Groups and Trash appear as separate headings at the bottom of the column. 

These can be clicked to expand them. 

The central column shows the current list of documents. The view is limited to 50 items – to view the 

next or previous 50, use the navigation arrows that appear in the bottom right corner of the panel. To 

change the sorting order, use the dropdown menu that appears in the top right. To access the reader 

view for PDF documents, click on the PDF icon that appears. 

The right-hand column shows the details of the currently selected reference. To make changes to the 

reference, use the Edit button. You can access your notes using the Notes tab, and also add or modify 

notes using the interface. The right-hand column can be collapsed and retrieved using the blue tab that 

appears to its left. 

The search field, which appears in the top right corner, allows you to search your library using 

keywords. 

Adding references 

The Web Library allows you to add new documents to your library, by uploading them using your 

browser. 

Click on the blue ‘Add’ button that appears at the top left corner of the screen, and choose ‘Import 

document’. Browse to the location of the file you wish to upload, and select it to begin the upload 

process. 

The Web Library will automatically create a library entry for the reference, and will also attempt to 

extract metadata from the file. You should check and correct this metadata using the right-hand column. 

Using the ‘Add’ button, you can also opt to  
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• ‘Add entry manually…’ This will allow you to manually enter the details of a reference, creating a 
metadata-only library entry. 

• ‘Add New folder…’ to your library 

• Import external libraries in any of the following formats: EndNote (xml), RIS (.ris) and BibTeX 
(.bib) 

To exclude items from the Web Catalog (as described above) click the “Edit” button on the right panel 

and check the check box that appears near the bottom of the document details column. 

As in Mendeley desktop, documents can also be added by dragging and dropping documents to web 

the center panel.  

Organizing references 

References in the Web Library can be organized using many of the same approaches used in 

Mendeley Desktop. Changes made to your organizational structure will be reflected in  

Folders 

Any folders you have already created will be visible in the left-hand column. Click on one of these items 

to view references stored within the folder. 

To add new references to a folder, click the check box that appears next to its entry (multiple references 

can be selected at once) and click the ‘Add to’ button that appears in the top left of the main column. 

Select the appropriate folder from the list, and press the blue ‘Add’ button at the bottom of the interface. 

To create a new folder, use the blue ‘Add’ button that appears at the top left corner of the, and select 

‘Add folder’. Enter a name for the new folder into the popup interface and press ok. Your new folder will 

be automatically created and opened. Alternatively, you can use the “Create Folder” option available on 

the left-hand column under Folders to create new folders.  

To create sub folders or remove existing folders click on the name of the folder and then click on the 

three vertical dots that appear to the right of the name to open the folder options menu.   

. References can be added to subfolders using the ‘Add to’ tool. Click the plus symbol that appears next 

to the parent folder to expand its subfolders, and select the appropriate listing. 

Tags 

At present the Web Library does not support filtering by tags, but you can still add tags to references in 

order to use them in Mendeley Desktop. 

To add tags to a reference, click to select it and click the ‘Edit’ button, which appears in the right-hand 

column to begin editing the reference metadata. Scroll down to the ‘Tags’ field. You can enter a new tag 

by typing the appropriate label and adding a semicolon (;) once you’re done. The Web Library will then 

convert this into a tag element. You can remove existing tags by clicking the ‘x’ that appears next to 

them. 

Once done, press the ‘Save’ button to commit your changes. 

Filter views 

Similar to Mendeley Desktop, Web Library offers a number of built-in ways to filter your view easily: 

• Favorites – Filter your view to only items that have been starred in any Mendeley application. 
You can start a new reference at any time in Web Library by clicking on the star icon that 
appears next to the reference entry. 
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• My Publications – Filter your view to only items that have been added as your personally 
authored publications. You can add personal publications using the ‘Add to’ menu as described 
above. 

• Recently Read – Filter your view to a list of the most recently opened PDFs. Mendeley keeps 
track of which references you’ve read – on any device – allowing you to get straight back into a 
paper. 

Search 

The Web Library search field is located in the top right of the interface. Enter your search term, and 

click the magnifying glass – or press enter- to start the search. 

Note – unlike Mendeley Desktop’s context-specific search, Mendeley Web Library will always search 

your entire library. 

The PDF Reader 

For references with PDF documents attached, a PDF icon will be displayed next to the entry. Click this 

to open a new tab for the PDF Reader view of the document. 

 

While similar to the Mendeley Desktop PDF Reader, the browser-based reader has a slightly different 

layout. Most navigation and annotation tools are accessed from the main toolbar that appears at the top 

of the page. The elements from left to right are as follows: 

 

• Navigation menu  – accessed via the icon at the top-right corner, which resembles small 
images alongside lines of text. Click this to open a list of thumbnailed pages, allowing you to 
quickly navigate to a specific location within the document. You can also click the ‘Contents’ tab 
to view a list of key locations within the document. Note that ‘Contents’ is only accessible for 
documents that support this feature. 
Click the icon again to close the navigation menu. 

• Zoom options  – set your zoom level using the plus and minus buttons, or by 
picking a specific value from the dropdown menu. 

• Search field  – allows you to search for specific words or phrases within the 
PDF you’re reading. Using the left and right arrows to jump between different instances. Note 
that with some PDFs – such as scanned documents with no OCR – search may not be able to 
identify all instances. 

• Text selection tool  – accessed via an icon of an ‘A’ and a cursor. This allows you to 
select text within a document for copying and pasting. Once a passage has been selected, 
you’ll also see the option to highlight and/or add a note appear. 

• Pan mode  – accessed via the icon of a hand, this tool allows you to click to drag your view 
up and down. 

• Create sticky note  – click the icon of a sticky note to set this tool as active, and then click 
at a particular location within the PDF to add a sticky note. Type your notes into the field that 
appears. You’ll see that the PDF reader saves your notes as you add to them. Click anywhere 
outside the note to close it. 
Notes in a document will be indicated by a small, yellow sticky note icon, which can then be 
clicked to open. 
Sticky notes can be deleted by opening, and then clicking the trash can icon that appears in the 
top right corner. 

• Create highlight  – indicated by a highlighter icon, click this to set the tool as active and 
then click and drag across a passage of text to highlight it. 
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Highlighted passages can be ‘focused’ by clicking on them with the text selection tool active. 
Click outside the passage to disable the focus. While focused you’re also able to add a sticky 
note, or remove the highlighting entirely by clicking the trash can icon. 
 

• Select color  - indicated by a blue-colored circle, click on this to set the color for your sticky 
notes and highlights. You can choose from a range of 8 different colors.  
 

• More options  – click the icon of three vertical dots to open this dropdown menu. This 
allows you to either download or print the PDF. 
Note that these options will not currently include any notes or annotations. It is recommended 
that you use the PDF export functionality of Mendeley Desktop if you need to retrieve a copy of 
the PDF complete with annotations. 
 

• Account options  - click on the icon with your photo to access to: your profile, settings, 
support or to log out from Mendeley.  
 

Collaboration 

The Web Library allows you to access papers shared with groups of which you are a member but, 

unlike Mendeley Desktop, does not facilitate discussion directly. See below for more details of using 

groups on Mendeley Web. 

Click on the ‘Groups’ tab that appears at the bottom of the left-hand column to expand the list of groups, 

and click on a particular group name to access its resources. In the Web Library interface, public 

groups are indicated with a small globe icon, while private groups display a padlock icon. 

With public groups, you will be able to access the reference metadata of entries – as discussed in some 

detail above. You can use the Web Library interface to modify the details of papers shared with groups 

of which you are a member. 

With private groups, you will also be able to access the PDFs of shared papers. Click the icon to view 

the PDF. As with personal library PDFs, you’ll be able to add annotations and highlighting. Highlights 

and annotations added by other group members will also be visible. Click on the sticky note icons to 

see who added a specific contribution. 

Creating a new group in the Web Library 

You can create a new group by clicking the ‘Create Group…’ option, which appears under the ‘Groups’ 

tab in the left-hand column. This will take you outside of the Web Library interface to the group creation 

tool of Mendeley Web.  

Groups in Mendeley Web 
Mendeley maintains a directory of all publicly accessible groups, and also provides a web presence for 

each group. Private groups also have a web presence – access to which is determined by membership 

– but are not listed in the directory of groups. 
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Visit https://www.mendeley.com/groups/ to view a list of groups of which you are either a member or 

follower. Groups you personally own, or have the ability to administer, will also be listed under separate 

headings. 

 

Clicking on a group shows the main group newsfeed. This reveals details about who has recently 

added references to the group, as well as any discussion that has been posted. You can start a new 

discussion thread using the field that appears at the top of the newsfeed, or reply to an existing post 

using the comment field that appears underneath each thread. You can also ‘Like’ individual posts in 

order to show your approval. 

Use the left-hand menu options to switch between different views of the group: 

• Overview – The main newsfeed view. Provides details of the group as well as: 
- a Members pane with list of the members that allows following and inviting other members.  
- Add document weblet to share thoughts and documents with the team as in most social media 

feeds.  
 
[TIP – Mendeley Fields: try copy pasting a link from any external source. Mendeley will pull out 
all the metadata (including a picture, if available) and provide a snippet version of the article. 
This will automatically be posted to the group’s newsfeed and other members are able to like it, 
comment on it or share it.  
 

 
 

- Scan through what members are sharing and commenting as well as interacting in discussions.  

https://www.mendeley.com/groups/
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• Members – Provides a list of all group members. You can either browse, or search for a 
particular member using the search field, which appears in the top right of the page. 
 

• Documents – Provides a list of all references shared with a group. By default, these are 
ordered with the most recently added items first. 
Each paper listing will provide details of when it was added to the group, along with the number 
of readers (i.e. the number of Mendeley users with that reference in their personal library). 
Clicking on the name of any listed papers will take you to the Web Catalog entry for that paper. 
See below for more details of the Web Catalog. If viewing a private group, you will also have the 
option to download a copy of the shared PDF. 
 

• Settings – This option only appears for groups that you own, or can administer. You can use it 
to edit your group’s name, description, associated link or the thumbnail image for the group. 
You can also use this menu to monitor the amount of storage your group(s) are using. See 
Account limits for more details. 

You can find a more detailed guide to Groups in the Mendeley Resource Center. 

You can also find a dedicated guide to Private Groups in the Mendeley Resource Center. 

Finding new groups to join 

Use the search tool on https://www.mendeley.com/groups/ to search for new public groups to join. 

Groups are usually dedicated to a specific topic, or project. 

The main list of search results shows the number of members present in the group, as well as the 

number of references shared with that group – although remember that public groups only allow the 

sharing of reference metadata, so the ability to read those papers will depend on your ability to retrieve 

them from the relevant catalog or publisher. 

Click on the name of the group to view its listing. You can use the Overview tab to see a summary of 

recent activity. If you’re interested in joining as a member, click the green ‘Join this group’ button that 

appears in the top right of the page. You can also opt to become a follower of the group by opening the 

dropdown menu on the ‘Join this group’ button, and choosing ‘Follow this group’ instead. 

Group followers can view the contents of the group and access the references shared with it, but 

cannot modify the references or add new references to the group. 

If a group is set to be invite-only, you can apply to become a full member – but this application must be 

approved by the group owner/administrator. 

Creating groups 

As with Mendeley Desktop, the process of creating new groups is very straightforward. 

From the main Groups page - https://www.mendeley.com/groups/ - click the blue ‘Create new group’ 

button in the top of the screen. This opens the group creation tool, which is identical to that of Mendeley 

Desktop. 

See the section on Creating a group in the Mendeley Desktop guidance above for more details. 

Alternatively, see this page of the Mendeley Resource Center guide to Groups. 

https://community.mendeley.com/guides/groups
https://community.mendeley.com/guides/private-groups
https://www.mendeley.com/groups/
https://www.mendeley.com/groups/
https://community.mendeley.com/guides/groups/04-creating-new-groups
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The Web Catalog 
Mendeley takes all references added by users and uses them to populate the Mendeley Web Catalog. 

Sophisticated algorithms examine the various entries generated, in order to identify where multiple 

users have added the same paper and to identify the correct details for that document. 

For example, if three users all add the same paper with identical document details, the Catalog can be 

fairly confident that those details reflect the correct details of the paper. If three users add the same 

paper, but one user includes a typo in the title of the paper, the correct title is more likely to be taken 

due to the weight of numbers. Papers imported from a respected source – such as Science Direct – are 

also regarded as more trustworthy. 

Although the Web Catalog can be accessed by using the Literature Search feature of Mendeley 

Desktop, it can also be extensively browsed via a web browser. The Web Catalog can be a useful way 

to discover new references, but also learn important information about how specific references are 

being used by other researchers. 

Accessing the Web Catalog 

The Catalog can be accessed directly by visiting https://www.mendeley.com/research-papers/. From 

here it’s possible to initiate a catalog search by using the search field, or to browse specific disciplines 

for popular papers. A catalog search can also be initiated from any page on Mendeley.com by clicking 

the magnifying glass that appears on the top toolbar, and ensuring the ‘Papers’ option is selected. 

Using the Web Catalog 

Each paper in the Catalog has its own page, which can be accessed by clicking on the name of the 

paper in search results, or in a group’s Papers tab. A Catalog entry page, such as 

https://www.mendeley.com/catalog/choose-good-scientific-problem/, provides a number of details about 

the paper. These include: 

• Title 

• Author 

• Discipline 

• Publication details – including identifiers such as DOI, ISBN etc. 

• Access details of where the full text of a paper can be retrieved/purchased 

• Abstract 

In addition to this metadata, Mendeley also provides a number of details based on Mendeley usage. 

These include: 

• Readers – i.e. the number of Mendeley users who have this reference in their library 

• Usage by discipline 

• Commonly applied tags 

• Related papers – other references commonly found to be read in conjunction with the current 
paper. 

The Web Catalog entry for a specific paper also allows you to easily add it to your personal library. Just 

click the green ‘Save reference to library’ button which appears in the top right corner of the page. 

If the paper already exists in your library, this button will be replaced with a white ‘View in Mendeley 

Desktop’ button. Pressing this will switch your focus from your web browser to Mendeley Desktop, and 

start a sync. Once the sync completes the relevant reference will be selected for viewing. 

https://www.mendeley.com/research-papers/
https://www.mendeley.com/catalog/choose-good-scientific-problem/
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 Mendeley Web Importer 
The Mendeley Web Importer allows Mendeley users to grow their libraries by retrieving the details of a 

reference being viewed in a web browser. This can be a single catalog entry, or a list of results from a 

tool such as Google Scholar. The details of the reference are then used to create a Mendeley library 

entry. Wherever possible Mendeley will also attempt to download a copy of the relevant PDF file. 

The Web Importer is a snippet of code that is added to the bookmarks or favorites menu of your 

browser. This can then be run at any time when viewing a suitable page.  

Mendeley Web Importer is available for all major browsers (Chrome, Firefox, Safari and IE)  

Installing the Web Importer 

The Web Importer can be installed by visiting https://www.mendeley.com/reference-management/web-

importer/. Follow the instructions that appear on this page.. 

Using the Web Importer 

When viewing a reference that you want to add to your personal library, open your favorites/bookmarks 

menu and click the ‘Save to Mendeley’ entry. 

The Mendeley Web Importer will run, creating a small popup within your browser. It will attempt to 

retrieve details of the reference you’re viewing, and will provide a summary of the details it finds. Once 

you’re satisfied, press the ‘Save’ button to add this reference to your library.  

If multiple references are detected on the page (such as a list of Google Scholar results) the Web 

Importer will provide a list of references, allowing you to choose which specific results to add to your 

library. Click the plus symbol which appears next to each item in order to add it to the batch, or use the 

‘Save all’ button to add them all at once. 

Once a reference (or multiple references) has been added to your library, you can use the button that 

appears in the Web Importer to switch over to Mendeley Desktop. Once the automatic sync completes, 

your new references will show up in your library. It’s recommended that you review the details of the 

new entries to verify them. 

 

https://www.mendeley.com/reference-management/web-importer/
https://www.mendeley.com/reference-management/web-importer/
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[TIP – Web Importer compatibility: The Mendeley Web Importer is designed to work with a wide 

range of online catalogs and repositories, but due to the huge variety of implementations, it cannot 

provide 100% accuracy in all situations. If you come across an online catalog with which Mendeley Web 

importer does not work please let us know by creating an entry on our feedback forum 

It is strongly recommended that you review any references added to your library, and use either 

Mendeley Desktop or the Web Library to correct a document’s metadata. 

Advanced Web Importer usage 

In addition to adding references to your library, you can use the Web Importer to add personal touches 

at the time of import. 

When the popup opens after pressing the ‘Mendeley Web Importer’ icon on a single reference (as 

opposed to a list from Google Scholar) you’ll see that a number of additional fields are available: 

• Choose folders or groups – Use this dropdown menu to select either a specific folder or 
specific group to which you intend to add the reference. 

• Edit – Add/edit article metadata such as: article type, title, authors, abstract, details as well as 
adding personal tags – separated by semicolons – to the reference. If you do not want the 
reference to be added to the Mendeley Catalog, just check the ‘Exclude from catalog’ box at the 
bottom.  

Once you press the ‘Save’ button and the reference is successfully added to Mendeley, press the 

‘Open in Mendeley’ button to switch over to Mendeley Desktop and initiate an automatic sync. Once the 

sync completes, your new reference will be present – along with the additional personal Notes, Tags or 

filing options that you provided.  

 

Using Mendeley’s social features 
In addition to allowing you to manage your reference materials, Mendeley offers a number of features 

designed to enable you to grow your academic profile and to connect with other researchers from 

around the world. 

The most basic element of this is your Mendeley profile, as it allows you to showcase yourself and your 

work. Completing your profile and keeping it actively maintained helps to make the most of Mendeley’s 

other social features, which are covered in detail below. 

Mendeley profiles 
 

http://feedback.mendeley.com/forums/4941-general
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At the time of account creation, a Mendeley profile is also generated. Initially this contains some very 

basic information, so it’s a good idea to add more detail to your profile. Your Mendeley profile includes a 

progress widget, which suggests next steps in order for you to achieve profile completion. 

Completing your profile 
You can view your profile at any time by clicking on your name, which appears in the top right hand 

corner when viewing Mendeley.com. Editable fields are indicated by a small pencil icon. Click on the 

appropriate ‘Edit’ link in order to start adding information. In order to achieve 100% profile completion, 

follow these steps:  

• Add your photo – Add a photo of yourself. This will appear on your profile, as well as in other 
locations – such as in the membership list of a group you join. Having a photo on your profile 
makes it more appealing to other researchers – they’re more likely to connect with you if they 
see a picture. Plus, it’s always nice to put a face to a name. 
 

• Add your Editorships – if any to share where you have been working 
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• Add your research interests – Adding specific topics to this area of your profile has a number 
of benefits. Firstly, it helps Mendeley to make more accurate recommendations to you when 
using the Suggest feature (see the section on Mendeley Suggest for more detail). These 
interests will also be visible to others who visit your profile. A specific research interest is likely 
to catch the eye of potential collaborators. 
 

• Add your publications – If you’re a published author, you can add your publications to your 
Mendeley profile to claim them. This makes it easier for other Mendeley users to discover your 
work, as well as helping to connect with you if they’re interested in collaborating. 
Adding your publications will also allow you to access information about their usage on 
Mendeley – giving you a valuable insight into how your papers are being read and used. 
You can add your publications directly from this page, by adding papers to the ‘My Publications’ 
folder in Mendeley Desktop or Web Library, or by completing the Scopus Author Claim process 
covered in detail below. 
 

• Add your Professional Experience and your Education history – Affiliating yourself with a 
particular institution helps other people at that university/school/institution find you on Mendeley. 
It also helps to differentiate you from other people with a similar name. 
 

[TIP – Add other research IDs – currently you can add your Scopus ID (read more about how 

here) and your ORCID (You can connect only by linking your ORCID profile from your Mendeley 

and vice versa. Or connect and import your profile information, this will import your ORCID works, 

biography, keywords, employment and educational history to Mendeley straightaway.  

In addition to these steps, you should aim to complete your personal summary, your professional 

experience and education history. Keeping these maintained will provide other Mendeley users with 

current information about you. 

Changing account settings 
In addition to your public profile, you may also need to edit your account settings. Click the dropdown 

arrow that appears next to your name and photo (in the top right corner of Mendeley.com) and choose 

‘Settings’ to start making changes on one of the following menus: 
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• Account settings – Use this menu to change your email address or password. You can also 
delete your entire Mendeley profile. 

• Privacy – Use this menu to change how your Mendeley profile behaves. By default, your entire 
profile will be visible to anyone. You can modify individual settings for different aspects of your 
profile: 

o Whether you want your new publications are automatically added to your profile by 
Mendeley or not 

o Whether you want to approve other Members follow requests or not 
o Whether you want your profile page to be indexed or not by search engines (checking 

this box means your profile will not show up in any search results outside Mendeley)  
 
 

• Notifications – This menu allows you to modify the circumstances under which Mendeley will 
display notifications or contact you via email. Notifications are divided into general activity and 
group activity.  

• Job preferences: for now, this menu currently links to Mendeley Careers. Job preferences is 
not available just yet.  

• Billing – If you have purchased a Premium Plan, you will find the payment details and 
transaction history listed here. You can also register a new payment card, if required. 
Note that this does not apply to Premium accounts earned via MIE or Librarian Certification, but 
only to Premium Plans that have been independently purchased directly from Mendeley. 

Connecting with other researchers 
Connecting with other researchers is one of the major benefits of having an active Mendeley profile. It 

opens the door to collaboration, as well as helping to find other people who are active in your field. 

Finding other Mendeley Users 
There are a few options open to you when trying to find new contacts: 

• Name search – Click the magnifying glass that appears on the main toolbar, and make sure 
‘People’ is selected. Enter the name of the individual you are trying to find. Find the appropriate 
person in the list of search results and either click their name to view their profile, or use the 
‘Follow’ button to start following them immediately. 

• View followers – When looking at other users’ profiles you’ll be able to see a list of whom 
they’re following. This can often be a good way to build a network of likeminded researchers. 

• Browse groups – When viewing a group, use the Members tab to view a list of members of 
that group. You can then access profiles, or opt to follow individuals directly from the 
membership list. 

• Wider networking – Add your Mendeley profile to other social media and to your email 
signature. This will allow others to identify and connect with you. 

Following 
Following another Mendeley user is a way of marking them as somebody you want to stay in touch 

with. Whenever their profile is updated you’ll see a notification in your newsfeed. For example, if they 

add a new personal publication to their profile, you’ll be informed via notification. 

You can view a list of people you’re following via your personal profile. You’ll also see a list of who is 

following you. 

Note that some users require their followers to be approved (as discussed above). 

Messages 
You can send messages to any Mendeley user – whether you’re following them or not. 



 

Mendeley Manual for librarians 

35 

To send a message, visit another user’s Mendeley profile and click the ‘Message’ button that appears. 

Alternatively, when viewing a list of Mendeley users (such as members of a group, or in a search result) 

click the dropdown menu that appears next to their name, and choose ‘Send Message’. 

If another Mendeley user sends you a message, you’ll receive an email notification – unless this has 

been disabled. 

Mendeley Suggest 
Until recently a premium-only feature, Mendeley suggest was made available to all users in January 

2016. Mendeley Suggest provides bespoke recommendations of papers based on a number of factors. 

To access Mendeley Suggest visit https://www.mendeley.com/suggest/. This can also be accessed via 

the main toolbar of Mendeley.com or the left-hand menu in Mendeley Desktop. 

 

The suggestions you receive are generated using the following factors: 

• All articles in your library 

• Research interests listed on your profile 

• Popular papers in your discipline – i.e. the most popular papers of all time 

• Trending papers in your discipline – i.e. papers that have recently increased in popularity 

• The most recently added paper in your library 

These suggestions are updated on a regular basis. 

Mendeley Suggest learns from your behavior, so by using it to add papers to your library you’re actively 

improving the quality of the suggestions you receive. To add a suggestion to your library, just click the 

‘Save reference’ button that appears beneath its details. 

Mendeley Stats 
For published authors, Mendeley offers the ability to gain valuable information about how your papers 

are being read, as well as the impact they’re having. 

To begin the process, you need to ‘claim’ your publications by connecting your Mendeley account with 

a Scopus Author Profile. This will then generate a dashboard, providing an overview of activity 

connected to your publications, and allowing you to access a more detailed view for individual 

publications. 

https://www.mendeley.com/suggest/
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Visit www.mendeley.com/stats/ or click on the ‘Stats’ option in the main toolbar of Mendeley.com. 

Important: Stats will become part of your Mendeley Profile soon. When that happens, the Stats 

dashboard will be integrated with your profile so you can monitor the impact of your work and showcase 

it to others in one place. Read this article for more information  

Claiming a Scopus Author Profile  
Before you can use Mendeley Stats, you need to identify which Scopus Author Profile you want to 

connect with your Mendeley account. Upon visiting Stats for the first time you’ll be prompted to do this 

using an integrated tool. 

To identify the Scopus Author Profile that you wish to claim, you can either search for your name, or 

use the title of a paper you’ve authored. 

• Search by name –Mendeley will initially search for Scopus authors using the name you provided 
when creating your Mendeley account. This may return the desired result, but you may also find 
that you need to modify the search terms to find your own listing. Remember that Scopus may 
use a variation of your name. 
Click the ‘Add’ link that appears next to the profile that you wish to claim. 

• Search by article – You can also claim a Scopus Author Profile by entering the name of one of 
your published papers. Pick the correct paper from the list of results and find your name in the 
list of authors. 
Click ‘Add’ when you’ve identified the correct listing. 

At this stage, you have the chance to review the details of the profile you’re about to claim. Make sure 

you’re happy before proceeding.  

You also have the option to add the publications taken from your Scopus Author Profile to your 

Mendeley profile. If you don’t want to do this just untick this checkbox. 

Using Stats 
Once you’ve completed the claim process you’ll have access to detailed statistics for the publications 

associated with your Scopus Author Profile. 

 

The dashboard (available at www.mendeley.com/stats/) provides aggregated totals for the following 

items: 

http://www.mendeley.com/stats/
https://blog.mendeley.com/2016/11/30/stats-is-becoming-part-of-your-mendeley-profile/
http://www.mendeley.com/stats/
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• Number of publications 

• Number of citations of your work 

• Downloads of your publications from Science Direct 

• Number of Mendeley users with your publications in their personal library 

 

You’ll also see a graph of download and citation information. By default, this shows the last 12 months 

of activity, but you can also use the ‘Historical view’ to show activity for a longer period. 

Further down the page you’ll find detailed statistical breakdowns for each individual publication. Click on 

the ‘View stats’ button that appears under each to view a dedicated page for that paper. 

  

The dedicated view provides detailed usage information for each paper. The amount of data provided 

depends on exactly where a paper was published – Mendeley can provide more information about 

publications published in Elsevier Journals, for example. 

Reporting problems with Stats 
Although delivered by Mendeley, Stats relies heavily on Scopus – particularly its Author Profiles. If the 

papers associated with your Scopus Author Profile are incorrect or incomplete, you will need to contact 

Scopus directly to request a correction. 

If you have claimed the wrong Scopus Author Profile and need to make a correction, contact the 

Mendeley support team. 

Mendeley Data 
Mendeley Data (http://data.mendeley.com/) is a service that allows researchers to upload, access and 

browse datasets anywhere, for free – On completing their free registration, researchers can browse 

datasets, add datasets of interest to their personal “My Datasets” page, or submit a New Dataset.   

Mendeley Data is designed for use via a wide range of devices – desktop, iPhone, iPad – so these 

options can be pursued at researcher’s own convenience, wherever they happen to be. Researchers 

can upload any number of files of up to 2GB each. 

Force-11 Compliant Research Data Citations and DOIs – Research data that is added to Mendeley 

Data will include a Force11-compliant citation, allowing other researchers to easily cite the work.  Force 

11, “a community of scholars, librarians, archivists, publishers and research funders” has established a 

https://www.scopus.com/feedback/author/home.uri
https://www.scopus.com/feedback/author/home.uri
http://support.mendeley.com/
http://support.mendeley.com/
http://data.mendeley.com/
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set of data citation principles designed to safeguard and promote the importance of data as part of “the 

enduring scholarly record”§.  This is a new and distinctive citation type which will play an increasingly 

important role in the quantification of scholarly value and will, of course, be of acute interest to the 

research community.  A unique DOI will be provided for each version of a dataset that is added to the 

system, ensuring that its citation will always be valid. 

 

Safe, Secure Archiving – Consistent with the recognition of the scholarly value of research data, 

Mendeley Data has teamed up with DANS (Data archiving and Networking Services) to ensure that all 

material posted on the Repository is preserved permanently offline with DANS’ dark archive storage.   

From dataset to article and back again – Data posted on Mendeley Data can continue to form the basis 

of full research articles.  In the case of Elsevier journals, datasets from Mendeley Data will be peer-

reviewed along with their parent article, creating a more rigorous and inclusive publication process.  

Subsequently, posted datasets will feature links to any published articles which they have informed, 

regardless of publisher.  This approach is convenient, transparent and enriches the overall research 

process.  

Share easily and securely – Guidelines governing submissions to the Mendeley Data have been kept 

as open as possible, although all content must be academic in nature. Users can privately share their 

data with colleagues, representatives of funding bodies, or anyone else who might prove useful in 

moving their work forward.  They have full control over who can see and download their research data 

and are free to add and remove collaborators as their sharing needs change.  The licensing schema 

associated with Mendeley Data are as follows –  

- CC0 1.0 
- CC BY 4.0 (Creative Commons Attribution 4.0 International) 
- MIT (MIT License) 
- Apache-2.0 (Apache License 2.0) 
- BSD 3-clause (BSD 3-Clause ('Revised') License) 
- BSD 2-clause (BSD 2-Clause ('Simplified') License)</option> 
- GPLv3 (GNU Public License Version 3) 
- CC BY NC 3.0 (Attribution-Non Commercial 3.0 Unported) 

 

About Research Data 

Over the last two decades the print library has become the digital library, while the models which 

govern research access have multiplied and evolved.  The data underpinning research articles – facts 

and statistics gathered for further reference or analysis, the output of a measurement device, data from 

social surveys, digital scans, etc. – is rapidly becoming as important as the articles themselves.  

Researchers are increasingly demanding access to research data to build on the results of their own 

work or that of others, or as a potential starting point for further collaboration.  At the same time, funding 

bodies are revising their policies to encourage – or even mandate – researchers to make their research 

data available.  

 

 

 

                                                 
§ https://www.force11.org/group/joint-declaration-data-citation-principles-final 

https://www.force11.org/group/joint-declaration-data-citation-principles-final
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Links & additional resources 

• Mendeley Data is at: http://data.mendeley.com/ 

• The Force 11 Data Citation Principles can be found at: https://www.force11.org/group/joint-declaration-
data-citation-principles-finalhttps://www.force11.org/group/joint-declaration-data-citation-principles-final 

 

Mendeley Careers 
 

Finding the right job is important to build your expertise, further your research and get the exposure you 

need to develop your career. And job listings are not always about finding your next position, but 

keeping up-to-date in your field, or across disciplines. 

 

Mendeley Careers service, which selects thousands of relevant science and technology job postings 

from the leading job boards, academic institutions, company employers, and recruitment agencies 

across the world. 

You will be able to search and apply for your next position on Mendeley. Sign up for email alerts 

tailored to your search criteria, and upload your resume to let recruiters and jobs come to you. 

Mendeley Careers will also offer guides and resources to help you with your job search and to develop 

your career further. 

Mendeley Careers is available on https://www.mendeley.com/careers/  

  

http://data.mendeley.com/
https://www.force11.org/group/joint-declaration-data-citation-principles-final
https://www.force11.org/group/joint-declaration-data-citation-principles-final
https://www.mendeley.com/careers/
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Mendeley Institutional Edition (MIE) 
Mendeley Institutional Edition (MIE) is a version of Mendeley designed for purchase and use on an 

institutional basis. By purchasing an MIE license, a university or school provides premium access for all 

its researchers, along with an added layer of functionality intended to provide valuable usage data and 

analytics to the institution’s library team. 

MIE is sold by Elsevier and is often used in conjunction with other key Elsevier products, such as 

Scopus and Science Direct. 

Benefits of MIE 
In addition to all the features accessible to regular Mendeley users, MIE also offers several key 

benefits: 

Institution-wide access to premium features  
To empower all of your researchers with more productivity and collaboration power. See below the 

comparison chart between Mendeley Free and Mendeley Institutional Edition  

 Mendeley Free Mendeley Institutional Edition  

Features for Researchers   

Cite and Reference Yes Yes 

Read and Annotate Yes Yes 

Mendeley Suggest Yes Yes 

Researcher Profile and Stats Yes Yes 

Career Portal Yes Yes 

Data repository Yes Yes 

Personal Library storage 

space 

2GB 5GB 

Shared Library storage 

space 

100MB 20GB 

# Private groups 5 Unlimited 

Private group size 25 100 

Features for Institutions   

Premium institution-wide 

collaboration features 

No Yes 

Institutional Homepage No Yes 

Usage Analytics  No Yes 

Content consumption 

Analytics 

No Yes 
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Link resolver integration No Yes 

Alumni Policy No Yes 

Customer Support Service Via Online only Through Elsevier OSCS and 
Online, 24/5 

 

Institutional Page with Insights for librarians   
to enable librarians to better administer and support their institutional information objectives and the 

researchers needs. 

 

Mendeley provides Analytics to MIE customers in the form of the Analytical Dashboard in the with 

Mendeley Web and a Monthly MIE report in HTML (with downloadable data) sent to the owner of 

schools Institutional Page 

 

The data dashboard tracks which journals are being read the most by the institution’s faculty and 

students, allowing their library to optimize their subscriptions – meaning, they can cancel journals that 

are not getting used, and subscribe to journals which are popular, but not yet provided by the library. 

This enables librarians to get more value out of resources and provide a stronger service to their 

researchers. 

Moreover, the MIE data dashboard tracks the faculty’s publications: In which journals are they 

publishing, and how much impact – measured in global readership – do these publications have? This 

helps institutions gather information for research excellence assessments and other reports, as well as 

highlighting to them who their current and future star researchers are.  

Check the tables below for more in-depth details about the metrics and insights provided  
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Report Category Metric Use case 

Web 

Analytics 

Content Top Journals Understanding what Mendeley 

Members are reading can help in future 

journal and collection purposes 
Highly read articles 

Monthly 

Report 

Population Total current users with institutional 

email address and in MIE group 

You can use growth analytics to justify 

cost per user and ROI on you 

Institution’s MIE investment.   

Acquisition New users per month (last 6 months)  

New users per quarter (all time) 

Demographics Users by academic status By monitoring monthly Growth, 

Discipline and Status you can also 

understand the effectiveness of internal 

marketing activities such as training and 

e-mail campaigns 

Users by academic status by quarter 
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Report Category Metric Use case 

Web 

analytics 

Groups Groups joined by members (all time, year, month & 

week) 

With MIE, you will be 

able to gauge the 

collaboration efforts of 

your researchers. 

These statistics allow 

you to see how 

socially active your 

Mendeley population 

is and what they are 

using Mendeley for. 

Monthly 

Report  

Total Current Groups created 

Number of groups created and joined by quarter 

Engagement Number of groups joined 

Group actions (posts, likes, documents added, comments) 

Number of users in group 

Number of private groups by Member count (Including 

Owner) 

 

 

Report Category Metric Use case 

Web 

analytics 

Groups Groups joined by members (all time, year, month & 

week) 

With MIE, you will be able 

to gauge the collaboration 

efforts of your researchers. 

These statistics allow you 

to see how socially active 

your Mendeley population 

is and what they are using 

Mendeley for. 

Monthly 

Report  

Total Current Groups created 

Number of groups created and joined by quarter 

Engagement Number of groups joined 

Group actions (posts, likes, documents added, 

comments) 

Number of users in group 

Number of private groups by Member count 

(Including Owner) 
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Alumni Policy  
to grant to the Alumni from a subscribing institution the right to access of 12 months of the same 

premium access according to the terms and conditions of that Policy. 

Support promoting Mendeley and training users at your Institution  
Mendeley provides online training and user adoption roll out programs customized to your needs, 

including train-the-trainer sessions.  

 

24/5 priority global customer support  
Users and institutions get priority access to Mendeley’s first level support 24 hours Monday to Friday. 

For more details, please see www.elsevier.com/solutions/mendeley/Mendeley-Institutional-Edition. 

MIE and Librarian Certification  
As part of the Level 3 reward, certified librarians are entitled to 500 free premium upgrades for use at 

your institution**. 

BENEFIT 
Librarian Certification 

Reward 

Paid for version 

(Mendeley 

Institutional Edition) 

Number of premium 

upgrades 500 users (12 months only) Unlimited users 

Number of private groups Unlimited 

(Down to 5 after 12 months) 
Unlimited 

Number of collaborators 

per group 
Up to 50  

(Down to 25 after 12 months) 
Up to 100 

Individual storage space 5 GB  

(Down to 2GB after 12 months) 
100 GB 

Group storage space 5 GB  

(Down to 100 MB after 12 months) 
100 GB 

 

This benefit can be exchanged for a significant discount on an MIE purchase. Please contact 

certificationprogram@mendeley.com if you are interested in this deal. 

 

 

                                                 
** Limited to 1 librarian per institution, although multiple librarians can contribute to the level 3 assessment. 

 

http://www.elsevier.com/solutions/mendeley/Mendeley-Institutional-Edition
mailto:certificationprogram@mendeley.com
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